Send Us Your Comments

Preface

1 Introduction

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Sales Offline Overview</td>
<td>1-1</td>
</tr>
<tr>
<td>Oracle Sales Offline Prerequisites</td>
<td>1-2</td>
</tr>
<tr>
<td>Oracle Sales Offline Key Features</td>
<td>1-3</td>
</tr>
<tr>
<td>Hot Keys</td>
<td>1-6</td>
</tr>
<tr>
<td>Oracle Sales Offline Integrations</td>
<td>1-6</td>
</tr>
<tr>
<td>Accessing Oracle Sales Offline</td>
<td>1-7</td>
</tr>
<tr>
<td>Sync Preferences Form</td>
<td>1-7</td>
</tr>
<tr>
<td>Navigating in Oracle Sales Offline</td>
<td>1-8</td>
</tr>
<tr>
<td>Keyboard Navigation in Oracle Sales Offline</td>
<td>1-9</td>
</tr>
<tr>
<td>Setting Synchronization Preferences</td>
<td>1-12</td>
</tr>
<tr>
<td>Synchronizing Data</td>
<td>1-12</td>
</tr>
<tr>
<td>Conflict Resolution</td>
<td>1-14</td>
</tr>
<tr>
<td>Non-Validated Records (Rejected Records)</td>
<td>1-17</td>
</tr>
<tr>
<td>Client Logging</td>
<td>1-19</td>
</tr>
<tr>
<td>Date Picker Technology</td>
<td>1-20</td>
</tr>
<tr>
<td>My Filter and Address Filter Additions</td>
<td>1-20</td>
</tr>
<tr>
<td>Enabling Multi-Operating Unit Access</td>
<td>1-22</td>
</tr>
<tr>
<td>Version Identification in Oracle Sales Offline</td>
<td>1-23</td>
</tr>
<tr>
<td>Status Bar Messages</td>
<td>1-23</td>
</tr>
</tbody>
</table>
2 Managing Tasks
Overview of Managing Tasks ................................................................. 2-1
Entering Transactions and Details ....................................................... 2-2

3 Managing Leads
Overview of Managing Leads ............................................................... 3-1
Creating an Opportunity from a Lead ............................................... 3-2
Leads and Sales Methodology ............................................................. 3-3

4 Managing Opportunities
Overview of Managing Opportunities ................................................... 4-1
Overview of Managing Opportunity Line Level Forecasts .................... 4-2
Creating a Quote from an Opportunity ............................................... 4-6

5 Managing Quotes
Overview of Managing Quotes ............................................................ 5-1
Quotes and Operating Units ............................................................... 5-2
Defaulting Business Rules ................................................................. 5-2

6 Managing Customers
Overview of Managing Customers ....................................................... 6-1

Index
Send Us Your Comments

Oracle Sales Offline User Guide, Release 12.1
Part No. E13566-04

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

• Are the implementation steps correct and complete?
• Did you understand the context of the procedures?
• Did you find any errors in the information?
• Does the structure of the information help you with your tasks?
• Do you need different information or graphics? If so, where, and in what format?
• Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Oracle Sales Offline

• Oracle Sales

• Microsoft Excel - Oracle Sales Offline is a Microsoft Excel workbook which allows you to work in a disconnected fashion. Oracle Sales Offline works on a client-server based architecture. The client code is written in Visual Basic for Applications (VBA) using macros.

• The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the Oracle E-Business Suite User’s Guide.

How To Use This Guide

This document contains the information you need to understand and use Oracle Sales Offline.

• Chapter 1 provides an introduction to Oracle Sales Offline.

• Chapter 2 provides information on creating and updating a task.

• Chapter 3 provides information on creating and updating leads.

• Chapter 4 provides information on creating and updating opportunities.
• Chapter 5 provides information on creating and updating quotes.
• Chapter 6 provides information on creating and updating customers.

See Related Information Sources on page ix for more Oracle E-Business Suite product information.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and provide customer support according to the Oracle service request process. Information about TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.

Structure

1 Introduction
2 Managing Tasks
Related Information Sources

Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite’s business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

Online Documentation

All Oracle E-Business Suite documentation is available online (HTML or PDF).

- **PDF** - See the Oracle E-Business Suite Documentation Library for current PDF documentation for your product with each release. The Oracle E-Business Suite Documentation Library is also available on My Oracle Support and is updated frequently.

- **Online Help** - Online help patches (HTML) are available on My Oracle Support.

- **Release Notes** - For information about changes in this release, including new features, known issues, and other details, see the release notes for the relevant product, available on My Oracle Support.

Guides Related to All Products

Oracle E-Business Suite User's Guide

This guide explains how to navigate, enter data, query, and run reports using the user interface (UI) of Oracle E-Business Suite. This guide also includes information on setting user profiles, as well as running and reviewing concurrent programs.

You can access this guide online by choosing "Getting Started with Oracle Applications" from any Oracle E-Business Suite product help file.

Oracle Application Framework Personalization Guide

This guide describes how to personalize Oracle Application Framework-based Oracle E-Business Suite application pages as an end-user and as a personalization administrator using the Oracle Application Personalization Framework.

Oracle E-Business Suite System Administrator's Guide Documentation Set


Guides Related to This Product

Oracle Quoting User Guide

Oracle Quoting enables you to create and manage customer quotes across all sales and interaction channels and if approved by the customer, convert these quotes into orders. This guide describes how to create and modify quote templates, add and configure simple and related products, manage pricing and pricing adjustments, determine customer credit worthiness, and perform real-time global product availability checks.

Oracle Sales Offline Implementation Guide

Oracle Sales Offline enables you to remotely manage your sales efforts without logging in every time to Oracle Sales. You can use the template provided by Oracle Sales Offline to download and upload sales information without the need to install additional software. To implement this, you must have first installed Oracle Sales, Oracle Quoting,
and Oracle Web Applications Desktop Integrator. You must also configure timezones and timezone conversions.

**Oracle Sales User Guide**

Oracle Sales enables sales professionals plan and manage the sales process from leads to opportunities to quotes including the tracking of competitors for products within opportunities. It is integrated in the E-Business Suite and optimized for use with wireless. You can use the sales dashboard to view open opportunities, proposals, quotes, top customers, leads by age and by campaign, the latest sales forecast, and your calendar tasks.

**Oracle TeleSales User Guide**

Oracle TeleSales enables telesales agents manage the sales cycle, from prospects to booked orders. It offers a multi-channel selling solution that leverages all sales channels: whether selling over the phone, through the web or through mobile devices. Its E-Business Center offers a cross-application desktop for all Oracle call center applications, and provides elements of Service and Collections for a comprehensive customer view. You can use Oracle TeleSales for comprehensive customer management, list generation, lead, opportunity, and pipeline management, quote and order generation, event registration and collateral fulfillment.

**Oracle Trading Community Architecture User Guide**

Oracle Trading Community Architecture (TCA) maintains information including relationships about parties, customers, organizations, and locations that belong to your commercial community in the TCA Registry. This guide enables you to use the features and user interfaces provided by TCA and by other Oracle E-Business Suite applications to view, create, and update Registry information. For example, you can import batches of party data in bulk from external source systems into the TCA Registry, merge duplicate parties, sites, and customer accounts, generate time zones for phones and locations, and run various customer reports.

**Installation and System Administration**

**Maintaining Oracle E-Business Suite Documentation Set**

This documentation set provides maintenance and patching information for the Oracle E-Business Suite DBA. *Oracle E-Business Suite Maintenance Procedures* provides a description of the strategies, related tasks, and troubleshooting activities that will help ensure the continued smooth running of an Oracle E-Business Suite system. *Oracle E-Business Suite Maintenance Utilities* describes the Oracle E-Business Suite utilities that are supplied with Oracle E-Business Suite and used to maintain the application file system and database. It also provides a detailed description of the numerous options available to meet specific operational requirements. *Oracle E-Business Suite Patching Procedures* explains how to patch an Oracle E-Business Suite system, covering the key
Also included are recommendations for optimizing typical patching operations and reducing downtime.

**Oracle Alert User’s Guide**

This guide explains how to define periodic and event alerts to monitor the status of your Oracle E-Business Suite data.

**Oracle E-Business Suite Concepts**

This book is intended for all those planning to deploy Oracle E-Business Suite Release 12, or contemplating significant changes to a configuration. After describing the Oracle E-Business Suite architecture and technology stack, it focuses on strategic topics, giving a broad outline of the actions needed to achieve a particular goal, plus the installation and configuration choices that may be available.

**Oracle E-Business Suite CRM System Administrator’s Guide**

This manual describes how to implement the CRM Technology Foundation (JTT) and use its System Administrator Console.

**Oracle E-Business Suite Developer’s Guide**

This guide contains the coding standards followed by the Oracle E-Business Suite development staff. It describes the Oracle Application Object Library components needed to implement the Oracle E-Business Suite user interface described in the *Oracle E-Business Suite User Interface Standards for Forms-Based Products*. It also provides information to help you build your custom Oracle Forms Developer forms so that they integrate with Oracle E-Business Suite. In addition, this guide has information for customizations in features such as concurrent programs, flexfields, messages, and logging.

**Oracle E-Business Suite Installation Guide: Using Rapid Install**

This book is intended for use by anyone who is responsible for installing or upgrading Oracle E-Business Suite. It provides instructions for running Rapid Install either to carry out a fresh installation of Oracle E-Business Suite Release 12, or as part of an upgrade from Release 11i to Release 12. The book also describes the steps needed to install the technology stack components only, for the special situations where this is applicable.

**Oracle E-Business Suite System Administrator’s Guide Documentation Set**

This documentation set provides planning and reference information for the Oracle E-Business Suite System Administrator. *Oracle E-Business Suite System Administrator’s Guide - Configuration* contains information on system configuration steps, including defining concurrent programs and managers, enabling Oracle Applications Manager features, and setting up printers and online help. *Oracle E-Business Suite System Administrator’s Guide - Maintenance* provides information for frequent tasks such as

**Oracle E-Business Suite User Interface Standards for Forms-Based Products**

This guide contains the user interface (UI) standards followed by the Oracle E-Business Suite development staff. It describes the UI for the Oracle E-Business Suite products and tells you how to apply this UI to the design of an application built by using Oracle Forms.

**Other Implementation Documentation**

**Oracle Applications Multiple Organizations Implementation Guide**

This guide describes how to set up multiple organizations and the relationships among them in a single installation of an Oracle E-Business Suite product such that transactions flow smoothly through and among organizations that can be ledgers, business groups, legal entities, operating units, or inventory organizations. You can use this guide to assign operating units to a security profile and assign this profile to responsibilities such that a user can access data for multiple operation units from a single responsibility. In addition, this guide describes how to set up reporting to generate reports at different levels and for different contexts. Reporting levels can be ledger or operating unit while reporting context is a named entity in the selected reporting level.

**Oracle Approvals Management Implementation Guide**

This guide describes transaction attributes, conditions, actions, and approver groups that you can use to define approval rules for your business. These rules govern the process for approving transactions in an integrated Oracle application. You can define approvals by job, supervisor hierarchy, positions, or by lists of individuals created either at the time you set up the approval rule or generated dynamically when the rule is invoked. You can learn how to link different approval methods together and how to run approval processes in parallel to shorten transaction approval process time.

**Oracle Diagnostics Framework User’s Guide**

This guide contains information on implementing, administering, and developing diagnostics tests for Oracle E-Business Suite using the Oracle Diagnostics Framework.

**Oracle E-Business Suite Flexfields Guide**

This guide provides flexfields planning, setup and reference information for the Oracle E-Business Suite implementation team, as well as for users responsible for the ongoing maintenance of Oracle E-Business Suite product data. This guide also provides
information on creating custom reports on flexfields data.

**Oracle E-Business Suite Integrated SOA Gateway Implementation Guide**

This guide explains the details of how integration repository administrators can manage and administer the entire service enablement process based on the service-oriented architecture (SOA) for both native packaged public integration interfaces and composite services - BPEL type. It also describes how to invoke Web services from Oracle E-Business Suite by working with Oracle Workflow Business Event System, manage Web service security, and monitor SOAP messages.


This guide describes how users can browse and view the integration interface definitions and services that reside in Oracle Integration Repository.

**Oracle e-Commerce Gateway Implementation Manual**

This guide describes implementation details, highlighting additional setup steps needed for trading partners, code conversion, and Oracle E-Business Suite. It also provides architecture guidelines for transaction interface files, troubleshooting information, and a description of how to customize EDI transactions.

**Oracle e-Commerce Gateway User's Guide**

This guide describes the functionality of Oracle e-Commerce Gateway and the necessary setup steps in order for Oracle E-Business Suite to conduct business with trading partners through Electronic Data Interchange (EDI). It also describes how to run extract programs for outbound transactions, import programs for inbound transactions, and the relevant reports.

**Oracle iSetup User's Guide**

This guide describes how to use Oracle iSetup to migrate data between different instances of the Oracle E-Business Suite and generate reports. It also includes configuration information, instance mapping, and seeded templates used for data migration.

**Oracle Product Lifecycle Management Implementation Guide**

This guide describes how you can define hierarchies of items using structure types, catalogs, and catalog categories, and define change categories and configure them for revised items or request lines. Oracle Product Lifecycle Management provides several predefined catalogs such as the Product Catalog, Asset Catalog, and the Service Catalog and predefined change categories such as change orders and ideas. Use this guide to learn how to define additional catalogs for browsing and reporting purposes and new change categories specific to your business needs. You can then learn how to set up users and responsibilities that provide or restrict access to these catalogs, catalog items,
and change management objects.

**Oracle Product Lifecycle Management User Guide**

This guide describes how to create and manage catalogs, create and maintain product attributes and attribute values, and manage item statuses and lifecycle phases. You can learn how to create change categories, create task templates for change orders, and create change management reports. In addition, you can use this guide to create roles, map roles to privileges, and maintain these roles.

**Oracle Web Applications Desktop Integrator Implementation and Administration Guide**

Oracle Web Applications Desktop Integrator brings Oracle E-Business Suite functionality to a spreadsheet, where familiar data entry and modeling techniques can be used to complete Oracle E-Business Suite tasks. You can create formatted spreadsheets on your desktop that allow you to download, view, edit, and create Oracle E-Business Suite data, which you can then upload. This guide describes how to implement Oracle Web Applications Desktop Integrator and how to define mappings, layouts, style sheets, and other setup options.

**Oracle Workflow Administrator's Guide**

This guide explains how to complete the setup steps necessary for any Oracle E-Business Suite product that includes workflow-enabled processes. It also describes how to manage workflow processes and business events using Oracle Applications Manager, how to monitor the progress of runtime workflow processes, and how to administer notifications sent to workflow users.

**Oracle Workflow Developer's Guide**

This guide explains how to define new workflow business processes and customize existing workflow processes embedded in Oracle E-Business Suite. It also describes how to define and customize business events and event subscriptions.

**Oracle Workflow User's Guide**

This guide describes how Oracle E-Business Suite users can view and respond to workflow notifications and monitor the progress of their workflow processes.

**Oracle XML Gateway User's Guide**

This guide describes Oracle XML Gateway functionality and each component of the Oracle XML Gateway architecture, including Message Designer, Oracle XML Gateway Setup, Execution Engine, Message Queues, and Oracle Transport Agent. It also explains how to use Collaboration History that records all business transactions and messages exchanged with trading partners.

The integrations with Oracle Workflow Business Event System, and the Business-to-Business transactions are also addressed in this guide.
Oracle XML Publisher Administration and Developer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce outputs to meet a variety of business needs. Outputs include: PDF, HTML, Excel, RTF, and eText (for EDI and EFT transactions). Oracle XML Publisher can be used to generate reports based on existing Oracle E-Business Suite report data, or you can use Oracle XML Publisher's data extraction engine to build your own queries. Oracle XML Publisher also provides a robust set of APIs to manage delivery of your reports via e-mail, fax, secure FTP, printer, WebDav, and more. This guide describes how to set up and administer Oracle XML Publisher as well as how to use the Application Programming Interface to build custom solutions. This guide is available through the Oracle E-Business Suite online help.

Oracle XML Publisher Report Designer's Guide

Oracle XML Publisher is a template-based reporting solution that merges XML data with templates in RTF or PDF format to produce a variety of outputs to meet a variety of business needs. Using Microsoft Word or Adobe Acrobat as the design tool, you can create pixel-perfect reports from the Oracle E-Business Suite. Use this guide to design your report layouts. This guide is available through the Oracle E-Business Suite online help.

Training and Support

Training

Oracle offers a complete set of training courses to help you master your product and reach full productivity quickly. These courses are organized into functional learning paths, so you take only those courses appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by Oracle University at any of our many Education Centers, you can arrange for our trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle University’s online education utility. In addition, Oracle training professionals can tailor standard courses or develop custom courses to meet your needs. For example, you may want to use your organization structure, terminology, and data as examples in a customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides the help and information you need to keep your product working for you. This team includes your Technical Representative, Account Manager, and Oracle's large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.
Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
This chapter covers the following topics:

- Oracle Sales Offline Overview
- Oracle Sales Offline Prerequisites
- Oracle Sales Offline Key Features
- Hot Keys
- Oracle Sales Offline Integrations
- Accessing Oracle Sales Offline
- Navigating in Oracle Sales Offline
- Keyboard Navigation in Oracle Sales Offline
- Setting Synchronization Preferences
- Synchronizing Data
- Conflict Resolution
- Non-Validated Records (Rejected Records)
- Client Logging
- Date Picker Technology
- My Filter and Address Filter Additions
- Enabling Multi-Operating Unit Access
- Version Identification in Oracle Sales Offline
- Status Bar Messages

**Oracle Sales Offline Overview**

Oracle Sales Offline gives you the information you need to remotely manage your sales efforts and offers sales organizations the functionality required in an interface that is...
both familiar and effective. Leveraging the capabilities of desktop applications, Oracle has designed a template that provides sales organizations a way to manage sales information without the need to install additional software.

The template is downloaded from Oracle Sales and provides upload and download data capabilities. Oracle Sales Offline provides you with the ability to view and edit sales information while your support organization does not have to support any additional technical software on laptop computers.

To manage and close deals successfully, sales teams often cross group boundaries, territories, and even company lines. Oracle Sales Offline works with Oracle Sales and with Oracle TeleSales to create a virtual sales team that enables the sharing of opportunities, contacts, notes, and other customer information between sales team members. You can automatically or manually assign opportunities to sales members. Sales representatives can see information from partners about their accounts as they prepare for on site meetings. Oracle sales automation modules complement each other and provide the solution for team selling in a dynamic environment.

Oracle Sales Offline imports and exports (synchronizes) information from an Oracle enterprise database and enables you to view and update your sales information remotely with your laptop computer. You can add, view, and edit customers, opportunities, leads, quotes, and tasks from your laptop, saving the changes for subsequent upload.

You can optimize your selling time in the field by having key customer information readily available. This enhances your relationships with customers and promotes company profitability. Oracle Sales Offline integrates with the Oracle Sales applications and is designed to maximize sales effectiveness in the mobile environment. Oracle Sales Offline is part of the Oracle E-Business Suite, an integrated set of applications that are engineered to work together.

**Note:** Oracle Sales Offline is NOT supported in Mac machines.

### Oracle Sales Offline Prerequisites

The following information describes the prerequisites for Oracle Sales Offline.

**Oracle Applications**

- Oracle Sales release 12.0 or later
- Oracle Quoting
- Oracle Web Applications Desktop Integrator

**System Requirements**

- Microsoft Windows 95/NT/2000/XP operating system
• Microsoft Internet Explorer
• Licensed copy of WinZip, PKZIP, or WinRAR
• Microsoft Windows Common Controls-2 6.0 (Mscomct2.ocx)

System Recommendations
• 500 MHz or higher processor
• 256 MB RAM or higher

To increase your knowledge of Oracle Sales Offline, Oracle provides many sources of information including documentation, training, and support services. We recommend that you review the latest release of Oracle Sales Implementation Guide and the Oracle Sales User Guide in addition to using the Oracle Sales application. There is also a number of Oracle Sales training classes available through Oracle University including an Oracle Sales Fundamentals course.

Oracle Sales Offline Key Features
Oracle Sales Offline includes the following features:
• Lead Management
• Opportunity Management
• Customer Management
• Offline Quoting
• Task Management
• Flexfield Support
• Home Tab - Non-Validated Records, New/Changed Items and Conflict Resolution
• Incremental Synchronization
• Synchronization Preferences Filters
• Multilanguage Support (MLS)
• Common Product Catalog
• Multi-org Access
• Data Filtering Tools

Lead Management
You can manage leads and qualify them into sales opportunities in Oracle Sales Offline. Leads can be prioritized so that you can target activities on hot leads first. Oracle Sales Offline gives you access to lead information such as notes history, and key contacts. All changes to the lead can be synchronized back to the enterprise database. Also, you can perform the lead to opportunity business flow in Oracle Sales Offline.

Opportunity Management
You can manage opportunities remotely through the sales cycle. Oracle Sales Offline gives you access to opportunity activities and statuses, notes history, key contacts and sales credits. You can create and update the opportunity information by adding new notes, and changing the opportunity status. Access to this information and the ability to update it enables sales organizations to sell more effectively. Sales team members can share information about call activity, major issues, and account strategy. All changes to the opportunity can be synchronized back to the enterprise database. Also, you can perform the opportunity to quote business flow in Oracle Sales Offline.

Sales Forecasting: Oracle Sales Offline enables you to build forecasts constructed from opportunities. Oracle Sales Offline supports forecast information at the Opportunity transaction level. You can add, edit and create Forecast information within an Opportunity in Oracle Sales Offline.

Customer Management
Oracle Sales Offline gives sales representatives the information they need to manage their sales efforts when they are on the road. Mobile sales agents have access to detailed customer information, product interests and notes about their customers. Contact information lets representatives identify key players within their accounts and share that information with other members of the sales team.

Offline Quoting
Oracle Sales Offline supports mobile quoting functionality. The quoting functionality enables you to maintain and develop customer quotes. You can view detailed quote information, such as customer account information, contact details, and ship-to and bill-to information. You can add, remove, and price products using offline quoting. You can perform manual price adjustments at the product line level. You can also synchronize all changes to the quote back to the enterprise database.

Task Management
Oracle Sales Offline supports task management features. You can download tasks that are assigned to you, or that you own. You can view and edit these tasks in Oracle Sales Offline, and you can create new tasks. Tasks can be stand-alone, or associated to an Oracle business object. You can use the Calendar form to display tasks for a particular day or date range in Oracle Sales Offline.

Flexfield Support
Oracle Sales Offline supports customer defined flexfields, where applicable. You can download flexfields established in the online sales applications to use in Oracle Sales Offline. You can add, view, and edit data captured in these flexfields, and have the data synchronized to and from the online sales applications.

**Home Tab - New Items, Non-Validated Records and Conflict Resolution**

The Home Tab of Oracle Sales Offline, the first window you see in the application, lists newly added or changed records during the last synchronization. Initially, the Home tab will not list any records. New or changed items are listed as the result of subsequent synchronizations. Records are listed in the various tables, depending on the source of the record. Non-validated records are also listed in the Home Tab.

The Conflict Resolution subtab is available in the Home Tab. The conflict resolution sheet displays conflicted records that occurred during synchronization, and provides a side-by-side comparison of the local client record and the associated server record. You can reapply or discard the conflict records directly through Oracle Sales Offline.

**Incremental Synchronization**

Oracle Sales Offline supports incremental synchronization for uploading and downloading sales data. During incremental synchronization, only the records that have been changed or added in Oracle Sales Offline are uploaded during synchronization, and only the records that have been added or changed in the online applications are downloaded.

**Synchronization Preferences Filters**

The Synchronization Preferences allows you to selectively download sales data based on Oracle business objects such as, organizations, leads, opportunities and quotes. These download options can be saved and edited.

**Multilanguage Support (MLS)**

Oracle Sales Offline is MLS compliant. Multilanguage Support includes:

- **Language Data Handling**: Support for characters from any language as data in the application.

- **Language Data Handling**: Support for local formats for date, time, number, address, and name.

**Common Product Catalog**

Oracle Sales Offline supports the common product catalog, which is used by all Sales applications. In the past, product categories were limited to interest type, primary codes, and secondary codes. Using the common product catalog, multiple levels of product categories are possible based on implementation needs. Product catalog security is inherited from the security set in Oracle Sales.

The common product catalog is part of Oracle Product Lifecycle Management and manages product hierarchy. Your product catalog is set up in Oracle Product Lifecycle Management. A hierarchical catalog called Product is seeded for use by Sales and
Marketing. You can either use this seeded catalog or create a new product hierarchical catalog with Product Categories.

**Hot Keys**

In the Sales Offline summary sheet Hot Keys are provided for:

- **Main tabs** - Home, Tasks, Lead, Opportunity, Quote, and Customer
- **Subtabs** - Home, Conflict Resolution, Organization, Contact and Person
- **Global buttons** - Calendar, Profile and Sync
- **Action buttons** - Reapply, Discard, Save and Create
- **Remove button** - Toggle remove button on task summary sheet

All the hot keys are identified by an underline and can be accessed with the key combination of Ctrl + Alt. However, for the remove button on the task summary sheet you can access the key with the combination of Ctrl + Alt and set the prompt value to control toggling.

**Note:** If any global hot keys conflict with the Sales Offline hot keys, global hot keys always get the preference. Sales Offline hot keys would not work in this case. However, the system administrator can change the application menu hot key for the conflicting hot keys menu name. Refer to the *Oracle Sales Offline Implementation Guide* for information on changing hot keys.

**Oracle Sales Offline Integrations**

Oracle Sales Offline works with Oracle Sales, but some features may not be available. Oracle Sales Offline integrates with:

- **Oracle Quoting:** Oracle Quoting is used to propose product solutions and perform negotiations, while enforcing consistent business rules throughout the sales cycle. Users can maintain quotes, and eventually convert quotes to orders. This integration applies only if offline quoting is used in Oracle Sales Offline.

- **Oracle Sales:** Oracle Sales is an application for sales professionals that simplifies and optimizes the task of planning and managing the sales process. Oracle Sales simplifies the sales process by providing complete visibility into the sales cycle, helping companies to plan and manage effective selling activities.
Accessing Oracle Sales Offline

Oracle Sales Offline is available from the online Sales application, in the form of a compressed file.

Reference

*Oracle Sales Offline Implementation Guide*

Login

Log in to Oracle Applications to access Oracle Sales.

Responsibility

Oracle Sales: Sales User

Navigation

Oracle Sales: Preferences Link > Sales Offline Template Download

Steps

For using Oracle Sales Offline in conjunction with Oracle Sales for the first time, download Oracle Sales Offline from the Preferences link of Oracle Sales before proceeding.

Navigate to the downloaded file SalesOffline.zip in your directory. Unzip the file into your folder and run Oracle Sales Offline by double-clicking on SalesOffline.xls. Enable macros when prompted.

If Oracle Sales Offline fails to open when you choose to enable the macros, verify the macros security is set to the medium or low level. You can do this by navigating to Tools > Macro > Security in Microsoft Excel 2000.

Click the Sync icon. Enter the requested user information and then click Sync. The synchronization preferences will display the first time you Sync.

You can filter your data using the Sync preference filters associated with the downloads. See Setting Synchronization Preferences for details. You can save these preferences to use in future synchronizations.

*Note:* Oracle Sales Offline is not supported in Mac machines.

Sync Preferences Form

The following sync preference filters are applicable to downloads:

- **Lead Preferences** - Filter by Status, Channel, Lead Rank, Budget Status, Time Frame, or Number of Records

- **Opportunity Preferences** - Filter by Status, Stage, Sales Channel, or Win Probability
• **Quote Preferences** - Filter by Operating Unit, Inventory Category Set (inventory item or product), Inventory Category, or Price List

You must select categories (from the Default Category Set or the Sales and Marketing Category Set) for download. You can select categories from multiple categories. You can select multiple lines from one category set by highlighting a row and using the Ctrl or Shift functions.

The operating unit dropdown displays your default operating unit and any other operating unit you are associated with. For example, you may be associated with Vision Operations, Vision Corporation and Vision Communications, USA. These operating units are linked to your login responsibility and the default is derived from the profile MO:Default Operating Unit. You can only select one Operating Unit in the dropdown. Additionally, the product information displayed in the Sync Preferences, Quote tab are the values associated to the Operating Unit you selected in the Operating Unit dropdown.

• **Customer Preferences** - Filter by Customer Category, or Country. Customer category filter is only used for Organization.

If Quote tab is removed (Refer to the *Sales Offline Implementation Guide* for information on removing the Quote Tab) the sync preferences form contains Inventory Preferences instead of Quote Preferences.

• **Inventory Preferences** - filtered by Inventory Category Set (Default Category Set or Common Product Catalog), Inventory Category, and Operating Unit.

**Navigating in Oracle Sales Offline**

In Oracle Sales Offline, tabs indicate the first layer of information and subtabs show further details. Links enable you to access detailed information about specific items.

The Table 1-1 describes navigation features and fields:

<table>
<thead>
<tr>
<th>Navigation Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Enables you to navigate among the areas of functionality in the application.</td>
</tr>
<tr>
<td>Subtab</td>
<td>Enables you to access additional functionality under a tab.</td>
</tr>
</tbody>
</table>
**Navigation Feature** | **Description**
--- | ---
Link or hyperlink | Enables you to navigate to additional levels of detail under the subtab.
Asterisks | Designate required fields. These fields have a white background. Fields with a white background and no asterisk are optional. Fields with a grey background are read-only.
Column headings | Enables you to sort rows of information. Clicking on a column heading will sort rows in ascending or descending order based on the information in the selected column.
Go button | Enables searches for a list of values.
**Ctrl F** | Enables you to search for a specific value.

**Keyboard Navigation in Oracle Sales Offline**

The following information describes how to use your keyboard to navigate in Oracle Sales Offline.

### Summary Sheet

The following table describes keyboard navigation for the Summary Sheet.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across the fields (cells) of the worksheet</td>
<td>Tab</td>
</tr>
<tr>
<td>Move vertically across the worksheet cells</td>
<td>Up/Down Keys</td>
</tr>
<tr>
<td>Move horizontally across the worksheet cells</td>
<td>Left/Right Keys</td>
</tr>
<tr>
<td>Open record hyperlinks/sorting columns on summary sheet.</td>
<td>Enter (For Excel 2000) Right Click Button and &quot;Open Hyperlink&quot; Shortcut (For Excel XP/2003)</td>
</tr>
</tbody>
</table>

### Cell Dropdowns

The following table describes keyboard navigation for cell dropdowns.
<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>View the list of available values for drop down</td>
<td>Alt+Up/Down</td>
</tr>
<tr>
<td>Select a value from the cell dropdown</td>
<td>Enter</td>
</tr>
</tbody>
</table>

**Hot Keys**

You can dynamically set hot keys for the following items. All of the hotkey characters are highlighted by an underscore.

Select Ctrl+Alt+Hot key to invoke any of these items.

- Calendar (Global Menu)
- Profile (Global Menu)
- Sync (Global Menu)
- Home (Menu)  
  - Home (Sub Menu)
  - Conflict Resolution (Sub Menu)  
    - Reapply (Button)
    - Discard (Button)
- Task (Menu)  
  - Create (Button)
  - Save (Button)
- Lead (Menu)  
  - Create (Button)
  - Save (Button)
- Opportunity (Menu)  
  - Create (Button)
  - Save (Button)
• Quote (Menu)
  • Create (Button)

• Customer (Menu)
  • Organization (Sub Menu)
    • Create (Button)

• Contact (Sub Menu)
  • Create (Button)

• Person (Sub Menu)
  • Create (Button)

**Forms/Screens**

The following table describes keyboard navigation for forms/screens for example, Create Opportunity Screen.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move forward across fields</td>
<td>Tab</td>
</tr>
<tr>
<td>Move backward across fields</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Move across tabs in the forms/windows</td>
<td>Ctrl + Tab</td>
</tr>
<tr>
<td>Toggle the value of radio button/checkbox</td>
<td>Space bar</td>
</tr>
<tr>
<td>View the list of available values for combobox/View Datepicker calender</td>
<td>Alt+ Up/Down</td>
</tr>
<tr>
<td>Select a value from the dropdown</td>
<td>Enter</td>
</tr>
<tr>
<td>Change the value from the list of available value for a combobox.</td>
<td>Up/Down Keys</td>
</tr>
<tr>
<td>Select values in LOV screen</td>
<td>Up/Down Keys</td>
</tr>
</tbody>
</table>

**Date Picker**

The following table describes keyboard navigation for the Date Picker.
### Function Key

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Date Picker calendar</td>
<td>Alt + Down</td>
</tr>
<tr>
<td>Change year</td>
<td>Ctrl Page Up/Down</td>
</tr>
<tr>
<td>Change month</td>
<td>Page Up/Down</td>
</tr>
<tr>
<td>Change days</td>
<td>Up/Down keys</td>
</tr>
</tbody>
</table>

### Toggle Remove Checkbox on Task Summary Sheet

- Select/highlight the cell that you want to toggle

- Ctrl + Alt + Hot Key (Refer to the Oracle Sales Offline Implementation Guide for information on how to set the hot keys for toggle.)

### Setting Synchronization Preferences

Oracle Sales Offline enables you to select preferences for synchronization. These preferences apply to the data downloaded from Oracle Sales. During the initial synchronization, Oracle Sales Offline, will, by default, perform a full download of necessary data. Using preferences to select subsets of data to download can contribute to improved application performance. You can modify these preferences after making your initial choices.

**Steps**

1. In Oracle Sales Offline, click the Profile icon.

2. Make your synchronization selection.

3. Click **Save** to save changes or **Sync** to start the synchronization process (which will save changes on completion).

### Synchronizing Data

The Oracle Sales Offline synchronization process uploads changes or additions to the server and downloads changed or added records back to Oracle Sales Offline on your laptop. You do not have to log into Oracle Sales to upload and download data. The synchronization function handles this process within Oracle Sales Offline. See Setting Synchronization Preferences for details on changing data synchronization preferences for your data downloads.

To ensure the synchronization function works correctly clean out (delete old files) your
Web ADI folder located in the Windows temp folder (C: \Documents and Settings\<username>\Local Settings\Temp\WebADI).

Steps
To synchronize data:
1. In Oracle Sales Offline, click the Sync icon.
2. The Sync Login window appears. Enter your user name and password.
3. Click OK. The Sync Console appears. A status bar shows the progress of the synchronization.

While the synchronization is in progress, you can:
- Go Offline, page 1-13 - Click to go offline while synchronization is in progress.
- Cancel Sync, page 1-14
- Show or Hide Details, page 1-14

Note: To disable the saving of your Sync Preferences, navigate to Oracle > Go Offline Autosave, and disable the autosave feature.

Note: When the data processing is prolonged, the access to the aslUploadEngine.jsp procedure times out and the application presents the following error message:

"Unexpected error has occurred whilst retrieving the file name"

To rectify this time-out issue, please increase the value of the timeout parameter in the httpd.conf file.

Go Offline
Go Offline enables you to use Oracle Sales Offline in a read-only (locked) mode. Any changes that you make while Oracle Sales Offline is in locked mode are not saved. Data synchronization must complete before you can create, modify, or save data in Oracle Sales Offline. Go Offline is not available during some parts of the synchronization. For example, you cannot choose Go Offline when the synchronization engine is downloading data.

If you click the Sync button, or attempt to save data while the synchronization is offline in locked mode, the following message displays:

Sync and Save disabled while in Locked Mode:
The buttons on the tabs (for example, Task or Lead) are not disabled (greyed out) while
Oracle Sales Offline is in locked mode. However the functionality associated with these buttons is disabled.

While in locked mode, if you close the worksheet, and then reopen it, you will receive this message:

**Do you want to complete the unfinished sync?**

You can do one of the following:

**Yes** - continues the synchronization. You will have to provide a login password. The Sync Console will appear and display the synchronization status bar.

**No** - enables you to remain in the offline (Locked mode).

**Cancel Sync**

Click to cancel the synchronization that is in progress. This button is functional at the beginning of the synchronization. As the synchronization progresses, you eventually will not be able to cancel, and this button will be disabled. The Cancel button is disabled when the synchronization process is writing to the enterprise database, to protect the integrity of the database.

**Show or Hide Details**

Click **Show** to expand the Sync Console and show synchronization processing messages. These messages are similar to a log file. Click **Hide** to hide the processing messages.

1. You will receive a message at the end of the synchronization process informing you that either the synchronization was successful or it failed to complete.

   If you receive conflict errors, navigate to the Home tab and click the Conflict Resolution subtab to resolve the conflicts in the Conflict Resolution screens.

   If you receive a server not found and not available error, contact your administrator for assistance.

2. At the successful end of the synchronization, messages indicating the synchronization is complete and reminding you to you save your data display. Click **Yes** to save or **No** to cancel the save.

   Oracle strongly recommends that you save your data after the synchronization completes.

**Conflict Resolution**

Using a remote application that synchronizes information with an enterprise database can result in data conflicts. Conflict resolution is critical to using a remote application successfully, and it is important that up-to-date and accurate information is written to
the enterprise database.

Note that the server record will always override your Oracle Sales Offline client record. If the same server and client record has been changed in between synchronization processes, a conflict will occur, and the server record will override your client record. You can resolve the conflict in the Home tab, using the Conflict Resolution subtab.

During a full and incremental synchronization, all conflicts associated with a particular user are downloaded. Error messages indicate the cause of the conflict.

Steps
To resolve conflicts between the Oracle Sales database and Oracle Sales Offline:

1. Open Oracle Sales Offline.

2. Click the Conflict Resolution subtab in the Home tab.

3. In the Conflict Resolution screen, you will see tables listing the conflicts that occurred during synchronization.

4. Click the link to see details of the conflicted record and make the necessary updates, if needed, before deciding to apply the changes or discard them.

   The left side of the form contains your local Oracle Sales Offline record while the right side of the form contains the Oracle Sales server record. The fields that caused the conflict are shown in red.

   If you choose Reapply, the Oracle Sales Offline record will override the Oracle Sales record. You must perform a synchronization for your record to be applied to the database. If you choose Discard, your Oracle Sales Offline changes will not be applied to the Oracle Sales server. If you discard the conflicts you do not need to perform a synchronization.

5. From the main Conflict Resolution screen you can select groups of conflicted records to Reapply or Discard. Select the checkbox by the record(s) you want to reapply or discard. If you want to reapply your changes to the server, click Reapply. If you want to discard the conflict, click Discard.

Conflict Resolution also displays the header and line object relationships in one clear view so you can decipher which line conflict is associated to the header record.

The information in the following table applies to Conflicted records:
## Conflict Resolution Information

<table>
<thead>
<tr>
<th>Conflict Resolution Scenario</th>
<th>Conflict Resolution Summary Sheet (table)</th>
<th>Conflict Resolution Detail Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Only Conflict</td>
<td>Header record is displayed and hyperlinked. Click on the header record to display the conflict resolution form.</td>
<td>The header record displays on the conflict details form, and you can choose to reapply or discard the header record.</td>
</tr>
<tr>
<td>Header Conflict and Line (one or many) Conflict</td>
<td>In this scenario, the header record is displayed and hyperlinked. Click on the header record to display the conflict resolution form. Each Line record conflict is displayed separately from the Header record conflict record. In Quotes each Line record conflict is hyperlinked, and it's associated Header record is displayed directly above each Line. Note however, that the Header is display only, and not hyperlinked. You can click on a Line record to display the conflict resolution form.</td>
<td>For the header conflict, the Header record is displayed in the conflict details form, and you can reapply or discard the header record. Only the header record will get reapplied or discarded. The child conflicts should be resolved before the header conflicts are resolved (reapplied or discarded). For the line (one or many) conflict, the Line record is displayed in the conflict details form, and you can either reapply or discard the Line record. Only the line record will get reapplied or discarded. Basic header information is displayed in a frame on the Line conflict form.</td>
</tr>
<tr>
<td>Line Only Conflict</td>
<td>Line record conflict is displayed and hyperlinked. The Line Record's associated Header record is displayed directly above the Line record conflict, but the Header is display only and not hyperlinked. Click on the line record to display the conflict resolution form.</td>
<td>The Line Record displays in the Conflict Resolution Detail form. You can either reapply or discard the line record. Basic header information will display in a frame on the Line conflict form.</td>
</tr>
</tbody>
</table>

**Note:** Sales Team, Notes, Lead and Opportunity contact, Person classification and Quotes sales credit conflict resolution is not supported.
Non-Validated Records (Rejected Records)

You can view rejected (non-validated) records in Oracle Sales Offline, as well as a message indicating why the record was rejected. Any record that is created in Oracle Sales Offline that does not pass the online validation rules during the upload-synchronization process is captured in a Non-Validated record table in the Home tab of Oracle Sales Offline.

In addition to displaying each record that did not pass the server validation rules, the non-validated records table also lists the reason the record was not applied to the server. You can rectify (Reapply, Discard or Cancel) the non-validated record while in this table.

The table contains two columns, Non-Validated Records and Sync Time.

- **Non-Validated Records column** - Contains the hyperlinked record name with hyperlink.
- **Sync Time column** - Contains the server date stamp for the non-validated record’s synchronization.

The most recent non-validated records are listed at the bottom of the table. If a non-validated record is a header record, then any accompanying line records are grouped together in the table, with the header record listed above the line records.

If the rejected records are related (for example, an opportunity header item and the related opportunity lines), these records are grouped together in the non-validated table. If a header record results in a NVR, it is the first item in the grouped records, followed by the related line items.

Both rejected header and lines records are listed. The following information applies to Quote, Opportunity, Lead, Organization, Contact and Person modules. It does not apply to the Task module.

The information in the following table applies to Non-Validated records.

<table>
<thead>
<tr>
<th>Non-Validated Record Scenario</th>
<th>Non-Validated Record Summary Sheet (table)</th>
<th>Non-Validated Record Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header Only NVR (lines will not get applied because the header did not pass server validation)</td>
<td>The Header record is displayed and hyperlinked. Click on the header record to display the NVR form. Line records are displayed, but not hyperlinked.</td>
<td>Header record is displayed in the NVR form, and you can either reapply or discard the header record. On reapply or discard all the line records will also get reapplied or discarded.</td>
</tr>
<tr>
<td>Non-Validated Record Scenario</td>
<td>Non-Validated Record Summary Sheet (table)</td>
<td>Non-Validated Record Form</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Header passes server validation (or the header was already synchronized and established) but line record does not pass validation</td>
<td>The header record is displayed but not hyperlinked. The line record, displayed directly below the header record is hyperlinked.</td>
<td>The line record is displayed in the NVR form and you can either reapply or discard the line record. Note that Notes, Lead, and Opportunity contact, person classification and quotes sales credit NVR is not supported.</td>
</tr>
<tr>
<td>Multiple lines do not pass validation (header was already synchronized and established).</td>
<td>The header record is displayed directly above the Line record conflict, but not hyperlinked. Each line record is displayed directly below the header record and hyperlinked. Each line is displayed directly below the header.</td>
<td>Each line record is displayed in the NVR form, and you can reapply or discard the line record.</td>
</tr>
</tbody>
</table>

Non-Validated and Conflicted Quote Header and Line Records

Quote NVR and conflict resolution support is the same as described in the previous section with the following exception:

- **If multiple lines are non-validated** - Non-hyperlinked header record is displayed before each line record. Basic header information is displayed in a frame on the Line conflict form.

- **If header and line (one or many) are conflicted** - Conflict header record is also displayed and non-hyperlinked before each line record. If there are n quote line/child record conflict(s) for a particular quote parent, the non hyperlinked quote name is displayed n number of times. These lines may be separated by other conflict quote records.

If the Sales Offline created quote line has a conflict/validation failure, the quote header status is changed to 'Sales Offline Error'. The quote becomes read only and this type of quote cannot be converted to an order. After quote line conflict/NVR record processing, Oracle Sales Offline changes the status back to Draft.

Failed Lead to Opportunity Flow Records

If you performed a Lead to Opportunity flow in Oracle Sales Offline and/or Oracle Sales between synchs, the lead will be displayed in the Conflict Resolution table of Oracle Sales Offline. This only occurs if the same lead record has been changed in both Oracle Sales and Oracle Sales Offline. The server changes will override the client changes for the
lead.

The Lead table of the conflict resolution sheet captures the lead header information. The lead will become read-only because of its Converted To Opportunity status, and only the Discard and Cancel buttons will be activated.

If any Lead child (for example, Sales Team, Lead Purchase Line) information is changed in Oracle Sales Offline, these child records will appear in the appropriate table of the conflict resolution sheet. None of these child changes will be uploaded to Oracle Sales. In the appropriate conflict form (for example, Lead Purchase Line, Sales Team), only the Discard and Cancel buttons will be activated.

When the Lead in conflict has been converted into an Opportunity, the following message displays:

Lead (LEAD NAME) has been converted into an opportunity in Oracle Sales. This lead is now read-only. Please discard this lead conflict, and make any appropriate changes to the leads corresponding Opportunity.

**Client Logging**

Oracle Sales Offline client log stores messages about these activities:

- Opening the template
- Loading sheets
- Synchronizing data

The timing statistics which are logged enable administrators to analyze Oracle Sales Offline's performance and identify issues that may arise when a large volume of records are processed.

The log file, aslclient.log, is located in the logs directory in the folder containing Oracle Sales Offline. Oracle Sales Offline supports the following kinds of log messages:

- Statement
- Procedure
- Event
- Timing
- Exception
- Error
- Unexpected

The two types of logging available are:
• **Normal**: Set at Oracle > Logging > Normal. The log messages of type TIMING, EXCEPTION, ERROR and UNEXPECTED appear on the client log file if you select this option. By default, the timing log is always enabled.

• **Detailed**: Set at Oracle > Logging > Detailed. All types of log messages appear on the client log file if this option is chosen.

  **Note**: Each time you open the Oracle Sales Offline template, the log file is copied to a .bak file and the .log file is cleared. To view the log, look at the log in the logs directory before you open the template. To restart logging, select Oracle > Logging > Reset. This deletes the existing log file and starts a new one during the current session.

### Date Picker Technology

Sales Offline uses date picker technology to ensure consistency across all of the Sales Offline modules. The date picker helps keep the date attribute consistent across all Oracle Sales Offline modules, and helps you maintain a consistent date look and feel between Oracle Sales and Sales Offline. The date picker is available on the following fields and sections.

- **Date Fields** - A date picker is displayed for all date fields.
- **Time Flexfields** - A time picker will display for all time flexfields. The time picker allows you to change the hour, minute and second values using the up/down arrows or the keyboard.
- **Standard Date/Time Flexfield** - When you choose a date from the date picker calendar display, the chosen date along with the current time will be displayed. You can edit the time using the up/down arrow keys or the keyboard.
- To keep the date look and feel consistent between the online and offline applications, Oracle Sales Offline downloads and uses the profile: ICX:Date format mask.

### My Filter and Address Filter Additions

Sales Offline supports the Auto Filter feature provided in Excel which allows you to filter data based on column headers that are exposed on each summary sheet. In Sales Offline this feature is called My Filter. Click on Oracle>Data Filter>My Filter to access it.

Sales Offline supports another filtering option called Address Filter, which allows you to further filter customer Information via an Address Filter form on the Organization, Person, and Contact summary sheets. Click on Oracle>Data Filter to access the filter features.
Note: You must enable or disable the My Filter feature individually for each of the subtabs.

The Data Filter menu contains the following options:

- **My Filter**: sets or removes the native Excel Auto Filter in Oracle Sales Offline. When you select the My Filter functionality, the native Excel auto filter dropdown becomes available for each column visible on the current summary sheet. All the summary sheets Offline (Organization, Person, Contact, Opportunity, Lead, Task and Quote) except the Home tab are supported by the My Filter.

- **Show All**: Removes any filter conditions already set via the native Excel Auto Filter and displays all rows on the tab. This sub menu item will only be highlighted when the native Excel Auto Filter has been set on a tab.

- **Address Filter**: Displays the Address Filter pop-up (only supported on the Customer tabs - Organization, Contact and Person). Provides more extensive data filtering than the native auto filter functionality in Excel. When you select the Address Filter sub menu from the Oracle>Data Filter menu, a pop-up form displays containing the address filter options. For example, when you select a country from the Country dropdown, the address fields below dynamically changes according to the global address setup used for the sales applications. You can choose to filter via one attribute, or many attributes.

The buttons on the Address Filter function as follows:

- **Cancel**: Closes the Address Filter form without saving any changes to the address attributes. The summary sheet will maintain the filter of any previously saved Address filter. If no address filter has been previously added to the Organization, Person or Contact summary sheet, the summary will display all of the Organization, Person or Contact records.

- **Save Filter**: Saves the value added into the Country dropdown and any value added into the address attributes. The Address Filter form will close and the summary sheet will only display Organization, Person or Contact rows that match the address criteria. You can use wildcards (%) in the Address Filter form. The Country dropdown is mandatory to filter via any address attribute. If you enter an address attribute without selecting a Country and click the Save Filter button, an error message displays.

- **Reset Filter**: Clears any values added into the Country dropdown and address attributes. Any previously saved Address Filter condition for that particular sheet will expose all the Organization, Person or Contact records.

**Address Search Criteria**

Address Search criteria is applied to all of the addresses related to a particular Organization, Person, or Contact. The search examines the identifying address as well
as any other addresses that have been created for each record.

Note: The Organization and Person subtabs show the Identifying Address on the summary sheet. Even though the search criteria may match an address for a particular customer, the matching criteria may not be part of the Identifying Address. In this case, the record displays on the summary sheet even though the address shown does not match the search criteria.

Enabling Multi-Operating Unit Access

The Multi-Org Access Control feature, also known as “Security by Operating Unit”, allows you to access secured data in one or more Operating Units within one responsibility. This feature uses the Security Profile concept, which allows system administrators to predefine the scope of access privilege as a profile option. You can define a security profile in hierarchical or listing mode, consisting of one or more Operating Units.

The following table describes the related profile options:

<table>
<thead>
<tr>
<th>Profile Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MO: Security Profile</td>
<td>Associates a predefined security profile to a user responsibility. This enables you to perform tasks for any operating units within your access. In Oracle Sales Offline you can work on any one of the operating units at a time. This can be specified in the sync preference form, which lists all the accessible operating units.</td>
</tr>
<tr>
<td>MO:Default Operating Unit</td>
<td>Specifies the default value of the operating unit list.</td>
</tr>
<tr>
<td>ASO: Operating Unit Override</td>
<td>Determines whether you can select any operating unit other than the default in the operating unit list box.</td>
</tr>
</tbody>
</table>

Opportunities and quotes created in Sales Offline are stamped with the operating unit on which you are currently working. During sync, only those quotes belonging to the selected operating unit are downloaded to sales offline. The default value of the quote order type list depends on the operating unit selected for synchronization. Any Inventory items that you can add to the quote are determined by the operating unit selected for sync.

MOAC Requirements for Oracle Sales Offline

In Oracle Sales Offline, you can download, and display Operating Unit information in
the Sync Preferences form. The Quote tab in the Sync Preferences form contains an Operating Unit dropdown displaying your default operating unit, and any other operating unit you are associated with.

The operating unit(s) is linked to your login responsibility. The default value for your Operating Unit dropdown is your default operating unit derived from the profile MO: Default Operating Unit.

Oracle Sales Offline allows you to select only one Operating Unit in the dropdown. The profiles, ASO: Override Operating Unit, MO: Security Profile, and MO: Default Operating Unit determine the logic for which Operating Unit values appear.

The product information displayed in the Sync Preferences, Quote tab will be those values associated to the Operating Unit you previously selected in the Operating Unit dropdown. The Inventory Category Set, Inventory Category are not dynamically generated based upon the value in the Operating Unit dropdown. Price List and product will be filtered based on operating unit.

Version Identification in Oracle Sales Offline

You can provide support personnel with a unique version number that identifies the implemented client version of Oracle Sales Offline by navigating to Oracle > About Sales Offline. This enables you to identify the version of the client in use when you report an Oracle Sales Offline problem.

Status Bar Messages

Status bar messages for phases that relate to the processes of File Open, File Close, File Save, and synchronization in Oracle Sales Offline are displayed in the Microsoft Excel status bar.
Managing Tasks

This chapter covers the following topics:

• Overview of Managing Tasks
• Entering Transactions and Details

Overview of Managing Tasks

Use the Task tab to view, create, and edit tasks. Tasks are your day-to-day activities related to customers, leads, and other sales-cycle events. You can use the Calendar button to access a Daily Task summary, listing your tasks occurring between specified start and end dates.

The Task tab displays all of your tasks, or tasks that have been assigned to you.

Note: Oracle Sales Offline does not support recurring tasks.

The task number is generated after synchronization.

Note: If Flexfield functionality has been implemented for a task, the Flexfield name, field, and Flexfield button are displayed.

Click Calendar to access a Daily Task Summary. This summary displays all of the tasks that have a start date of a specified day, or within a date range.

When you are using Oracle Sales Offline in conjunction with Oracle Sales, the following conditions apply:

• The Start Date and Due Date fields are displayed in the Create Task/Task Details page. Based on the profile Task Manager : JTF Tasks Default Date Selected, these fields will be mapped to the Planned, Scheduled and Actual Date type rows displayed in Oracle TeleSales.

• Only related contacts of the header-source Organization in Oracle Sales will be
downloaded from Oracle Sales to Oracle Sales Offline. Any contact added to the Task in Oracle Sales which does not have a contact relationship to the header-source Organization of the Task in Oracle Sales, will not be downloaded to Oracle Sales Offline.

Entering Transactions and Details

References Tab

The References tab in Task Details will not automatically populate reference rows. On synchronization, the newly created task and the reference rows will automatically be created in Oracle Sales and the appropriate reference rows are synchronized to the Oracle Sales Offline task. You have the option of adding additional rows in Oracle Sales Offline.

For example, if you select a contact, Brenda Johnson@ Business World, the references for the contact Brenda Johnson and organization Business World are automatically generated by the online applications after you synchronize.

Assignments Tab

The Assignments tab in Oracle Sales Offline will not automatically populate any assignment rows. With the next synchronization, the assignment’s owner row for the new task is automatically created in the online sales application, and the owner row is synchronized to the Oracle Sales Offline task record. The owner of the task is the Oracle Sales Offline user who created the task. You may add additional assignee rows in Oracle Sales Offline.
Managing Leads

This chapter covers the following topics:

• Overview of Managing Leads
• Creating an Opportunity from a Lead
• Leads and Sales Methodology

Overview of Managing Leads

Use the Lead tab to view and manage leads. Leads capture the initial contact with potential customers, gathering information to inform the sales organization regarding customer interest. When you enter a lead you can rank it and assign it to the appropriate sales resource.

Once enough information has been gathered, a lead can be qualified by a sales representative.

You can generate leads through various sources:

• Marketing campaigns and trade shows can generate leads which you can import into the system through the Lead Import process.

• TeleSales agents record lead information from phone calls.

• Field sales representatives record lead information from the field into a sales application.

Note: There is Flexfield support for Header and Purchase Item level flexfields for leads. If Flexfield functionality has been implemented for a lead, the Flexfield name, field, and Flexfield button are displayed.
Lead Details and Create Lead Window

The Main Details window in Lead Details and Create Lead contains a Methodology dropdown and a Stage dropdown. Sales Methodology captures your sales group’s best practices to assist in making sales. The Stage feature indicates the current level of the lead or opportunity. In Oracle Sales Offline system administrators can verify if Stage is mapped to a lead, an opportunity, or a lead and opportunity. If you select a Sales Methodology without choosing a Stage level from the Stage dropdown and attempt to apply/save the lead or opportunity, an error message displays.

When a Lead is created in Oracle Sales and synchronized down to Oracle Sales Offline, the Sales Methodology is editable until a Sales Methodology is actually associated to the Lead.

Note: The Sales Team tab in the Lead and Opportunity Details form contains an Owner radio button. Only one sales team member can be the owner of the Lead or Opportunity record. You cannot remove the Owner from the Sales Team unless you explicitly select another sales team member to be the owner.

Creating an Opportunity from a Lead

In the Lead Details window, click Lead to Opportunity.

This information will flow from the lead to the new opportunity into a new Opportunity Detail window:

- Lead Name (Lead Name will flow to Opportunity Name field)
- Customer Name
- Primary Contact
- Sales Methodology and Stage
- Currency
- Source (header level)
- Address
- Sales Team
- Contact

In Oracle Sales Offline you can convert any lead to an opportunity, regardless of status. In Oracle Sales you can only convert leads in open status. When the Lead to
Opportunity flow is initiated, the lead status will change to Converted To Opportunity and become read-only. If the lead does not have a sales methodology specified in Oracle Sales, then the newly converted opportunity will not have the sales methodology or corresponding sales stage specified.

**Leads and Sales Methodology**

If you create a new Lead and do not associate a Sales Methodology to it (for example, the Sales Methodology is null) you can still pick a Sales Methodology Value for this Lead using the Lead Details form. When the Sales Methodology is associated to the Lead, the Sales Methodology becomes read only.

Once a Methodology field is saved, you cannot update it. This applies to both Oracle Sales and Oracle Sales Offline. In some cases, a conflict may arise between Oracle Sales and Oracle Sales Offline if you set one Methodology in Oracle Sales and a different Methodology in Oracle Sales Offline. If this situation occurs and you perform a sync, a conflict in the Methodology field occurs and the Sales Offline Methodology value is overwritten by the Online Sales Methodology value.
Managing Opportunities

This chapter covers the following topics:

• Overview of Managing Opportunities
• Overview of Managing Opportunity Line Level Forecasts
• Creating a Quote from an Opportunity

Overview of Managing Opportunities

An opportunity is a potential sale. This process begins with the initial customer contact and ends when the sales representative makes or loses the sale.

Sales representatives can manage existing opportunities, assigned to them manually or automatically through Territory Assignment, or they can enter new opportunities.

By default, the sales representative who created the opportunity has full access to the opportunity. Full access to the opportunity means that the sales representative who created the opportunity can add other sales team members, assign sales credits, and rate the likelihood that the opportunity will succeed.

Note: There is Flexfield support for Header and Purchase Item levels for opportunities. If Flexfield functionality has been implemented for an opportunity, the Flexfield name, field, and Flexfield button display.

When you use Oracle Sales Offline in conjunction with Oracle Sales, the following conditions apply:

• The Opportunity header date will not trickle down to the forecast date on any purchase item line. Forecast dates will only appear on the purchase lines when a user explicitly enters a date on the line.

• All sales credit information for an Opportunity must be added or edited using Oracle Sales.
• When a new opportunity is created the user is added as the owner and the remove checkbox for the sales person entry is disabled.

• The Opportunity Details form contains a Currency dropdown.

• **Opportunity Details/Create Opportunity** - The Main Details window in Opportunity Details and Create Opportunity contains a Methodology dropdown and a Stage dropdown. Sales Methodology captures your sales group’s best practices to assist in making sales. The Stage feature indicates the current level of the opportunity. In Oracle Sales Offline system administrators can verify if Stage is mapped to a Lead, an Opportunity, or a Lead and Opportunity.

  For example, if you select Strategic Selling from the Methodology List of Values (LOVs) in the Opportunity Main Details window the Stage LOV will be populated with the appropriate LOVs such as Stage 1: Prospecting and Stage 2: Qualifying.

  If you select a Sales Methodology without choosing a Stage level from the Stage dropdown and attempt to apply/save the Lead or Opportunity, an error message displays.

---

**Overview of Managing Opportunity Line Level Forecasts**

Forecasting is a quantitative tool used to predict the amount of sales for a specified time period. Managers and sales team members can use forecasting to commit to the amount of sales that they will close by the end of the forecasting period.

Oracle Sales Offline supports forecast information at the Opportunity transaction level. You can add, edit and create Forecast information within an Opportunity in Oracle Sales Offline. The complete Forecasting tool is available in Oracle Sales. You can perform the following functions within Forecasting:

• **Opportunity Line Level adjustments**

  You can add a new product line to an opportunity and edit the best, forecast, worst amounts associated with the line. You can also manually edit the best, forecast, worst amounts associated with an existing opportunity line.

• **Edit Forecast field in Opportunity Header**

  You can change the Forecast amount in the Opportunity header. This Forecast field in the header sums the opportunity line Forecast amounts. This will overwrite the previous value in this field and the increase/decrease in the amount will be applied proportionately across the Forecast fields in the opportunity lines.

• **View Forecast Details**

  You can view Forecast Details (Revenue and Non Revenue Sales Credits) for each Opportunity line.
Opportunity Line Level Adjustments

When you add a new product line in Opportunity Details form the Best, Forecast and Worst fields are empty. When you enter an amount in the Amount field and select Save the Best, Forecast, and Worst amounts will be calculated based upon the setting of the ASN:Forecast Defaulting Type profile option. The opportunity must be in forecastable status.

You can modify existing opportunity product lines in several ways to impact the Best, Forecast, and Worst fields as described in the following table:

<table>
<thead>
<tr>
<th>Change</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual Entry</td>
<td>Amounts manually entered in the Best, Forecast, Worst fields will overwrite any values in those fields. Manually entered opportunity line Forecast amounts will be used to recalculate the opportunity header level Forecast field.</td>
</tr>
<tr>
<td>Changing Amount Field</td>
<td>If you change the Amount field on an opportunity line, the Best, Forecast, and Worst amounts for that line are recalculated. This recalculation overwrites any values currently in these three fields, including amounts that were manually entered. Recalculated opportunity line Forecast amounts will be reflected in the opportunity header level Forecast field.</td>
</tr>
<tr>
<td>Changing Win Probability</td>
<td>If you change the win probability for an opportunity and click from the Main Details tab to the Purchase Lines tab, the opportunity lines will be recalculated. This recalculation overwrites any values currently in these three fields, including amounts that were manually entered. Recalculated opportunity line Forecast amounts will be reflected in the opportunity header level Forecast field.</td>
</tr>
<tr>
<td>Changing Status</td>
<td>Changes to the opportunity Status will impact the Best, Forecast, and Worst amounts. If the opportunity is in a forecastable status and is changed to a nonforecastable status, the best, forecast, and worst amounts in the opportunity lines are changed to read only and the values are removed. If the opportunity is then changed back to a forecastable status, the best, forecast, worst amounts will be recalculated in the normal manner. Note that the recalculated best, forecast, and worst amounts will overwrite the previous amounts if they were manually entered.</td>
</tr>
</tbody>
</table>

Edit Forecast Field in Opportunity Header

The Main Details tab of the Opportunity Details and Opportunity Create forms contains
an Amount field which is always read only. The Forecast field which is editable, is a summation of all of the Forecast fields in the Opportunity Purchase Lines. You can manually enter an amount in the Forecast Amount field which will impact the Forecast amounts in each Opportunity line. The amount field in the header is read only. You can change the Header Forecast Amount but it impacts the forecast amounts in each opportunity line.

The Forecast field recalculates by changes in the Opportunity lines trickling up to the Opportunity header Forecast field. For example:

- **Changes in Opportunity lines impacting header Forecast field:** You add a new purchase line with a new forecast amount of $200 increasing the Forecast field at the header level by $200. Any changes or deletions to an existing opportunity line has the same effect in the Forecast field at the header level.

- **Changes in Opportunity header Forecast field impacting Opportunity lines:** If you manually enter a value in the Forecast field in the Opportunity header if will overwrite the previous value (if any) in this field. The change in the header Forecast field will be added/subtracted from each of the Forecast fields in the Opportunity purchase lines in the same manner as is done in Oracle Sales. The amount that is added or subtracted to/from each opportunity purchase line will be calculated based on the proportion of the total header level Forecast amount that each line’s Forecast amount represents.

- **Header Amount field in Opportunity Details window:** The Amount field is the sum of all the Opportunity Purchase Line amounts. It will always be read only. Changes from the Opportunity line impact the Opportunity header Amount field. However, since the Opportunity header is read only no header information can be edited an no information will trickle down to the opportunity purchase line amounts.

### View Forecast Details

In Oracle Sales Offline you can view (read only) the Forecast Details information (Revenue and Non-Revenue) for each Opportunity Purchase Line. Click the Forecast Details button located at each Opportunity Purchase Line to view the Forecast Details form. The Forecast Details information will be downloaded from Oracle Sales for existing opportunities. Forecast Details will be generated for new Opportunities created in Oracle Sales Offline.

- **Revenue Credits:** For opportunity lines created in Sales Offline the login user (if they are the Owner of the opportunity) will be added as a new row to the revenue frame as the Forecast Owner, and their associated Sales Group will appear in the Sales Group dropdown (if the user has two or more sales groups associated to them, the default sales group will be added). The Default from Opportunity Owner checkbox will also be checked. All fields will
be read only, and you will not be able to update or edit any Forecast Details information for opportunities created in Sales Offline.

For opportunity lines created in Sales where the login user is NOT the Owner of the opportunity, the login user will NOT be added as a new row to the revenue frame.

In this case, the Forecast Owner and their associated Sales Group will be displayed in the revenue frame. All fields will be read only, and you will not be able to update or edit any Forecast Details information.

• **Non Revenue Credits** There will not be any Non Revenue information added for newly created opportunities in Oracle Sales Offline.

• **Existing Opportunity Lines with Non Revenue users:**
  
  **Note:** This information is only for Opportunities created in Sales where non-revenue users have been added.

The Best, Forecast, Worst fields for non-revenue users will use the same calculations used in Oracle Sales. Each opportunity product line may have one or more non-revenue users associated with it.

• **Calculation for new non-revenue user:** The Non Revenue: Best, Forecast, Worst fields will be calculated based upon the Amount field for the opportunity line and the setting of the profile option ASN: Forecast Defaulting Type. The amounts calculated for the non-revenue user’s Best, Forecast, and Worst amounts will have no impact on the Forecast fields in the opportunity header, or the Best, Forecast, Worst amounts in the opportunity lines.

• **Calculation for existing non-revenue users:** You can change the non-revenue Best, Forecast, Worst amounts as follows:
  
  • **Manual Entry** – Not supported in Sales Offline.
  
  • **Changing Amount field** - If you change the amount field on an opportunity line, click the Recalculate button and then click the Forecast Details button, the Best, Forecast, and Worst amounts for all non-revenue users will be recalculated. This recalculation will overwrite any values currently in these three fields.
  
  • **Changing Win Probability**- If you change the win probability for an opportunity and click the Forecast Details, the Best, Forecast, and Worst fields for all non-revenue users will be recalculated. This recalculation will overwrite any values currently in these three fields.
Creating a Quote from an Opportunity

In the Opportunity Details window, click Create Quote to flow the opportunity information into a new quote. A new quote can be created based on information that flows from an existing opportunity. Only purchase item rows with a specified inventory item numbers (along with it's associated quantity) are carried over to the new quote.

This information will flow from the opportunity to the new quote into a new Create Quote window:

- Opportunity Name (flows to the Quote Name field)
- Customer Name
- Contact Name
- Sales Channel
- Opportunity Purchase Items (if they have specific inventory items on the purchase item line)
- Sales Team
- Address
Managing Quotes

This chapter covers the following topics:

• Overview of Managing Quotes
• Quotes and Operating Units
• Defaulting Business Rules

Overview of Managing Quotes

A quote is the communication of pricing and discounts for a particular sale. When the customer is ready to order a particular product they are notified of this available pricing and discount information through a quote.

**ASO: Enforce Account Relationships Profile:**

• If set to 'No', Billing and Shipping Customer can be any Organization (related or not) to the Quote Customer.

• If set to 'Yes', Billing and Shipping will be restricted to only the Quote Customer and those Organizations which are related to the Quote Customer.

In order to add items to a Quote, you must select specific Inventory Categories from the Profile - > Sync Preferences - >Quote tab. Only those items downloaded to Oracle Sales Offline can be used to add new products to the quote.

**Quote Header Tab**

• **Apply Button:** After a new Quote is created, click **Apply** to display additional tabs. The Tasks and Notes tabs will not display until you click **Save** then re-open the window.

• **Place Order Button:** The Place Order button will highlight on the Oracle Sales Offline, Quote Details window if the Place Order status transition is established in the Quoting application. If payment terms are not specified, the Place Order button is disabled.
Lines Tab

- **Service Item:** If you want to add a service item (for example, Warranty) to an existing product line, highlight the specific line by clicking the radio button associated with the product line, click **Add Services**, and search or select a service item to attach to the product line. You will only be able to add service item lines for product lines that are serviceable items.

Approvals Tab

**Approvals:** If you have approvals established for the Quoting application, the Initiate Approvals button will be enabled in the Approvals tab of the Quote Details window. Click Initiate Approvals to initiate the approvals process. The Quote must be synchronized for the approvals engine to begin the approval process. No approval rows are displayed in the Approvals tab of the Quote Details window.

Quotes and Operating Units

In Oracle Sales Offline you do not functionally add an operating unit when you create a new quote. The operating unit associated to the new quote is derived from the login users default operating unit. If the profile **ASO:Operating Unit Override** is set to **No**, the operating unit associated to a new Quote and the Operating Unit available in the Sync Preferences, Quote tab will be the your default Operating Unit (read only, non-editable).

If the profile is set to **Yes**, the operating unit values in the Sync Preferences, Quote tab will be all of the Operating Units associated to the your login responsibility. Any new quote that you create will contain the Operating Unit value that you selected in the Operating Unit dropdown of the Sync Preferences, Quote tab.

Defaulting Business Rules

On Quote Create, when you select the Customer for the Quote, the identifying address of that customer is defaulted in the Address Field. The contact is not defaulted. The Bill To and Ship To customer associated with the customer you selected in the main quote are also defaulted.

You can set the profile **ASO: Enforce Account Relationships** to Y or N:

- **If the profile is set to Y:** Only the Account information of the Quote Customer and his/her related parties are displayed. For example, the Billing and Shipping are restricted to the customer and his associated parties.

- **If the profile is set to N:** Account information of all organizations is displayed even though they are not related parties to the customer.

When you select the Bill To/Ship To customer the identifying address for that customer is displayed in the Address field as the Bill To/Ship To address.
The contacts will not be defaulted.

You can select one of the following Contacts:

• For the customer that you previously selected at the main Quote creation.

• For the Bill/Ship To customer.

When you select the Bill To/Ship To Customer Contact the identifying address for that Contact is displayed in the Address field as the Bill To/Ship To address.

**Customers/Contacts Radio Buttons for Quote Sold to, Shipping and Billing Addresses**

Select the Display:Addresses radio button and click on the 'GO' button next to the Address field to display all the addresses for the customer.

Select the Display:Contacts radio button and click on the 'GO' button next to the Address field to display all the addresses for the contact selected.

If you select the Contact radio button without first selecting the Contact and click the 'GO' button next to the Address Field, the error message "Please select a contact prior to selecting the address" displays.
Managing Customers

This chapter covers the following topics:

- Overview of Managing Customers

Overview of Managing Customers

The Customer tab contains three subtabs: Organization, Contact, and Person. By default, the Customer tab opens to the Organization window. Click the Contact subtab to open the Contact window, or the Persons subtab to open the Persons window. A person may be a contact for an organization and an Organization may have one or more contacts.

**Note:** There is Flexfield support for customers. If Flexfield functionality has been implemented for an organization or contact, the Flexfield name, field, and Flexfield button will display.

**Note:** Oracle Sales Offline does not support the Data Quality Management (DQM) feature for Organizations, Persons, or Contacts.

You can edit information for an existing Organization, Contact or Person by clicking on the Organization Name, Relationship link or Person Name. To specify a new Organization, Contact or Person click **Create**.

**Selecting an Existing Organization or Person Record**

When creating a Lead or Opportunity, in the Create Lead or Create Opportunity window choose an existing Organization or Person record by selecting the Organization or Person radio button. Click **Go** to list the organization name or the person’s name and address in the search results.

Enter a customer name or search for a customer. Enter the customer name in the customer field, or enter part of a customer name and click **Go**. Select a customer from the list of customers that displays or search for another customer.
Select an address by clicking **Add or Change** next to the address field. A list of customer addresses displays in the Select an Address window. Click the radio button next to the address and click **Select**.

**Creating a new record**

When creating a Lead or Opportunity, create a new Organization or Person by selecting the Organization or Person radio button. Click **Create Customer** to create a customer.

*Note:* Quotes may only be created for existing Organizations.

When you use Oracle Sales Offline in conjunction with Oracle Sales, a mobile user must create the Person record first and then add Contact relationship information in order to create the Contact relationship record.

After a successful sync, online users may access these newly created Contacts by drilling into the contacts information from Oracle Sales. None of the Person information added or edited within Oracle Sales Offline will be exposed in Oracle Sales. Only these Persons related to an active Organization (for example, Contacts) will be accessible in Oracle Sales.
Index

A
ASO: Operating Unit Override
MOAC Requirements for Oracle Sales Offline, 1-22
Audience, vii

C
Cancel Sync
Show or Hide Details, 1-12
Client Logging, 1-19
  Detailed, 1-19
  Normal, 1-19
Conflict Resolution, 1-14
  Header Conflict and Line (one or many), 1-16
  Header Only Conflict, 1-16
  Line Only Conflict, 1-16
Contact Radio button, 5-2
Contacts
  Contact Relationship, 6-1
Customer Management
  Offline Quoting, 1-3
Customers
  Managing, 6-1
Customers Radio button, 5-2

D
Data Filter, 1-20
  Address Filter, 1-20
  Address Search Criteria, 1-20
  My Filter feature, 1-20
  Show All, 1-20

E
Enabling Multi-Operating Unit Access
  MO: Security Profile, 1-22
  Enabling Multi-Operating Unit Access, 1-22

F
Failed Lead to Opportunity Flow Records, 1-17
Forecast Details
  Existing Opportunity Lines with Non Revenue users, 4-2
  Non Revenue Credits, 4-2
  Revenue Credits, 4-2
  view, 4-2

H
Home Tab, 1-3
Hot Keys, 1-6, 1-9
  Common Product Catalog, 1-3

I
Incremental Synchronization
  Multilanguage Support (MLS), 1-3

K
Keyboard Navigation, 1-9
  Cell Dropdown, 1-9
Date Picker, 1-9
Forms/Screens, 1-11

L
Language Data Handling
Language Data Handling, 1-3
Lead Management
Opportunity Management, 1-3
Leads in Oracle Sales Offline
Lead Details and Create Lead, 3-2
Overview, 3-1
Sales Methodology, 3-2
Stage feature, 3-2
Lead to Opportunity
Creating, 3-2

M
Managing Tasks, 2-1
Calendar button, 2-1
Tasks tab, 2-1
Microsoft Excel, vii
MO:Default Operating Unit
ASO: Operating Unit Override, 1-22
MO: Security Profile
MO:Default Operating Unit, 1-22
Multilanguage Support (MLS)
Language Data Handling, 1-3

N
Navigating in Oracle Sales Offline, 1-8
Non-Validated and Conflicted Quote Header and Line Records, 1-17
Non-Validated Record
Header Only NVR, 1-17
Non-Validated Record
NVR Form, 1-17
Summary sheet, 1-17
Non-Validated Records, 1-17

O
Offline Quoting
Task Management, 1-3
Opportunities
Opportunity Details, 4-1
Opportunities in Oracle Sales Offline
Overview, 4-1
Opportunity Header
Edit Forecast field, 4-2
Opportunity Line Level adjustments
Changing Amount Field, 4-2
Changing Status, 4-2
Changing Win Probability, 4-2
manual entry, 4-2
Opportunity Line Level Forecasts, 4-2
Edit Forecast field, 4-2
Opportunity Line Level adjustments, 4-2
Opportunity Management
Sales Forecasting, 1-3
Oracle Applications graphical user interface, vii
Oracle E-Business Suite, 1-2
Oracle Sales Offline
Accessing, 1-7
Integrations, 1-6
Overview, 1-1
Status Bar Messages, 1-23
Version Identification, 1-23
Oracle Sales Offline Key Features, 1-3
Incremental Synchronization, 1-3
Lead Management, 1-3
Synchronization Preferences Filters, 1-3
Oracle Sales Offline prerequisites
Oracle Applications, 1-2
system recommendations, 1-3
system requirements, 1-2

P
prerequisites
Oracle Applications, 1-2
system recommendations, 1-2
system requirements, 1-2
Profile Options
ASO: Operating Unit Override, 5-2

Q
Quote from an Opportunity
Create, 4-6
Quotes
Approvals tab, 5-1
ASO: Enforce Account Relationships Profile, 5-1
Lines tab, 5-1
Overview, 5-1
Quote Header Tab, 5-1

S
Sales Forecasting
  Customer Management, 1-3
Sales Methodology, 3-3
Security by Operating Unit, 1-22
Summary Sheet Hot Keys, 1-6
Synchronization Preferences
  setting, 1-12
Synchronizing Data, 1-12
  Cancel Sync, 1-12
  Go Offline, 1-12
Sync Preferences Filters
  Customer Preferences, 1-7
  Inventory Preferences, 1-7
  Lead Preferences, 1-7
  Opportunity Preferences, 1-7
  Quote Preferences, 1-7
Sync Preferences Form, 1-7

T
Task Management
  Flexfield Support, 1-3
Transaction and Details
  entering, 2-2
Transactions and Details
  Assignments Tab, 2-2
  References Tab, 2-2